
PART TWO

THE TRAFFIC MANAGEMENT SYSTEM



CHAPTER FIVE

SYNCING

Citations and collision reports that have been written on a handheld unit can be synced 
with the Form 5 Traffic Management System Software.  You can upload the citations 
and collision reports, view them on a desktop PC, analyze them, edit and submit them, 
and then off-load them to the courts.  Syncing is a simple process that requires you to 
set the handheld unit’s memory card into a card reader and then follow a few steps in 
the Traffic Management System.  Citations and collision reports only take a few minutes 
to sync, and they can be viewed immediately.

This chapter covers the syncing process, from preparing the citations and collision 
reports for syncing, to opening synced citations and collision reports in the Traffic 
Management System.

5.1 Preparing for Syncing

Whether you are working with citations or collision reports (or both), you must first make 
sure that the records are ready for syncing.  In the Citation module, this simply requires 
completing the citation, and then selecting Done in the Print/Export screen:

Fig. 5.1

Tapping Done will save the citation in the Citation Module and make it available for 
syncing.  If you write a citation and then exit before hitting Done, the unfinished citation 
will remain in the handheld unit, but it will not be made available for syncing.  This is 
also true of any voided citations (you have the option of voiding a citation when you exit 
the module before hitting Done).
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For collisions, preparing for syncing is somewhat different.  The Collision module 
requires that you complete a citation by using the Save & Validate function.  As shown in 
Section 3.1 of Chapter Three, the Save & Validate function quickly analyzes the collision 
report for any errors or missing data, and then lists all of the fields that need to be fixed.

Fig. 5.2

The errors are fields that must be corrected; the warnings are fields that might need to 
be corrected, depending on your requirements.  Fix the errors in the collision report, and 
then, when ready, hit the Save for Sync button.

Hitting the Save for Sync button is important -- without this, the collision report will not 
be prepared for syncing.  It will be saved in the handheld unit, but it will not transfer over 
to the Traffic Management System.

With either the citations or collision reports (or both) completed and properly saved, you 
are ready to sync them.

5.2 Syncing Citations and Collisions

You don’t need to sync the citations and collisions separately.  In a very convenient and 
efficient manner, the Handheld Report-Writing System syncs them all at one time.  You 
can run the sync process from either the Citation Main Menu or from the Collision Main 
Menu; each will allow you to sync all of the records in the handheld unit.

For convenience, we’ll just look at how this is done through the Citation Main Menu.  
Open the Main Menu and look for the Sync button.
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Fig. 5.3

When you hit the Sync button, the program will gather all the records and all the data.  
You will see a new screen, displaying a progress meter.  Once the meter reaches 100%, 
a status message will appear.

Fig. 5.4

The status message will display how many citations, collisions, FI cards, and tow forms 
have been copied to the chip (also known as the “memory card”).  If the message states 
that there are a certain number of “open” records, that means that you have citations or 
collisions that are unfinished or that were not prepared for syncing.

At the bottom of the screen, the program states: “Please remove chip and sync.”

To do this, follow these steps:

First, remove the memory card from the handheld unit and place the card in your card 
reader (which must be attached to the PC that is running the Traffic Management 
System).

144



Second, with the chip in the memory card reader, open Internet Explorer and go to the 
Login page of the Traffic Management System.

Third, input your username and password and log in.

Fourth, from the Main Menu, select Sync.

The Sync Window will appear.

Fig. 5.5

The Sync Window has sections for each type of record, and each section displays basic 
information (such as citation number, sync status, date, street, violator, and so on).

Now, click the Check Chip button at the bottom of the window.  This will tell the System 
to read the memory chip and see what records are on the chip.  The System will then 
display all of the records (citations, collision reports, FI cards, and tow forms) in the 
Sync Window.  Each record will have a check-box next to it.  The items that are checked 
are the ones that will be synced.

By default, all items that the System reads when you hit Check Chip will appear 
checked for syncing.  If there are records that you do not want to sync, uncheck them 
individually.

Fig. 5.6 shows a sample of what the Sync Window looks like after you press Check 
Chip.

145



Fig. 5.6

Once you’ve reviewed the records and checked the ones you want to sync (or if you just 
left them all checked), go ahead and start the sync process by clicking the Sync button.

As the System syncs the records, you will see the Status column change as each record 
is read in.  If the status reads Synced, that means that it has been successfully 
transferred.  If the status reads Already Exists, that simply means that the record has 
been synced before and is already in the System.

At the bottom of the Sync Window, you will see a status bar detailing the progress of the 
sync, as well as a message in red.  The message will change as the syncing continues, 
from Uploading Citations (or collisions, or other records), to Downloading Handheld 
Files, to Finalizing Chip Write.  When the process is finished, a small message will 
pop up and say Done.

NOTE: During the syncing process, do NOT remove the memory card from 
the card reader.  Removing the card will disrupt the syncing process.  Only 
remove the card after the Done message appears and you have exited the 
sync screen in the Traffic Management System.
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Once the sync process is complete, exit the sync screen.  You can now view, edit, 
submit, approve, print, and analyze all of your synced traffic records in the Traffic 
Management System.  Remove the chip from the reader and place it back in the 
handheld unit.  Allow the unit to return to the menu screen by itself before conducting 
any further actions.

Before we look at how to open and view records in the Traffic Management System, 
let’s take a look at two other aspects of the syncing process.  The first is how to delete 
records from the handheld unit; the second is how to fix a potential syncing error.

5.3 Deleting Records

After you have synced your citations and collisions with the Traffic Management System 
and placed the memory card back into the handheld, you are ready to begin using the 
handheld for writing more citations and collisions.  However, the sync process does not 
remove the existing citations and collisions (as well as FI cards and tow forms) from the 
handheld’s memory chip.  This is a safety feature that helps prevent accidental deletion 
of records.

However, if you want to delete the records from the handheld (once they have been 
synced), you can do so in a few easy steps.

To delete a citation, or several citations, open the Citation module on your handheld unit 
and go to the Main Menu.  From the Main Menu, select Delete.  A special Delete screen 
will open.  All of the existing citations will appear, and each will have a check-box next to 
it.

To delete an individual citation, check the box next to it, and then hit Backup and 
Delete.  To delete all the citations, check the box at the top that’s next to the Citations 
label.  This will select all the cites.  Then, just tap Backup and Delete (this process 
deletes the citations but also creates a safety backup file in case the citations need to 
be recovered).

Fig. 5.7
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To delete collision reports, first open the Form 5 Collision Module and go to the Main 
Menu.  From the Menu, select Open.  A list of existing collision reports will appear.

Fig. 5.8

Collision reports can only be deleted one at a time.  Select a report by tapping on it, and 
then hit the Delete button at the bottom of the screen.  You will be asked to confirm your 
decision.

Deleting any existing FI cards or tow forms is just as simple.  To delete an FI card, go 
the FI Card Main Menu and select Delete to open the Delete screen.  Select the card(s) 
you want to delete, and then hit the Delete button.

To remove any tow cards, go to the Tow Main Menu, open Delete, select the card(s) 
you want to remove, and then hit the Delete button.

And that’s it.  Removing synced records from the handheld will create more room for 
new records and also keep you from re-syncing the same items over and over.

5.4 Fixing the ActiveX Error Message

When syncing with the Traffic Management System, there’s a possibility that you will 
receive an ActiveX error message.  ActiveX is basically a “scripting” process that runs in 
Windows and Internet Explorer.  Internet Explorer is equipped to run ActiveX, but 
whether or not it will do so properly depends on how each version of IE is set-up on 
each individual computer.  If your version of IE requires additional set-up, you will see 
the message.

When you open the Sync screen, the following message might appear:
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Fig. 5.9

If you see this message, you can use the Download link at the bottom of it to access the 
necessary ActiveX components.  When you click on the download link, you will see the 
following message window:

Fig. 5.10

Go ahead and click Open.  The program will download and install the ActiveX 
components.  During the installation, simply follow the on-screen instructions, and if you 
are asked to overwrite a file, go ahead and click Yes (click Yes to any of these types of 
prompts).

When the installation process is finished, you can run the sync process in the Traffic 
Management System again.  You should no longer see the error message, and the 
records should sync properly.

However, there is a chance you will see a different message relating to how Internet 
Explorer handles ActiveX components.  This message looks like this:
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Fig. 5.11

If you receive this message do the following:

In Internet Explorer, go to the Tools menu at the top.

From the Tools menu, select Internet Options.

In the Internet Options window, click on the Security tab.

In the Security tab, select Custom Level.

Scroll until you see the options for ActiveX Controls and Plug-Ins.

Fig. 5.12

Select Enable for all of the ActiveX controls.  When you have finished doing this, click 
OK.  Close the Internet Options window.  Then, go back to the Traffic Management 
System and begin the sync process again.

Everything should work properly now.

150



5.5 Opening and Viewing Citations

Now that you have synced the traffic records from the handheld unit to the desktop 
Traffic Management System, you can open and view citations, open and view collisions, 
and also perform a number of other essential functions, such as reviewing and 
approving records, and sending data to NCATS.  Let’s take a look at how to do this.

After syncing, go to the Traffic Management System Main Menu.  Select Citations to 
open the Citation Menu.  From the Citation Menu, select Open Citations.  The System 
will display the Citation List, which shows citations contained within the database.

Fig. 5.13

The Citation List screen has a variety of convenient features, which we will look at one 
by one.

Officer Select List.  At the top left of the screen, just below the Crossroads Software 
logo, is a drop-down list containing officer names and ID numbers.  You can use this list 
to see citations written by a specific officer.  Just select the officer’s name and then hit 
the Go button.  By default, the list is set to “All.”  Whether you select “All” or specify a 
single officer, you might have to adjust the time period to see citations.  To do this, use 
the time options, discussed below.

Date. This field allows you to bring up citations that were written on a specific day.  
Write in the date using the standard eight digit date format (MMDDYYYY) and then hit 
the Reset button.

Remember that the Date field is optional.  You don’t necessarily have to specify a date.
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Show Last.  The series of radial buttons here allows you to look at citations for a certain 
time range: 1 Day, 3 Days, 7 Days, 2 Weeks,  Month, or All.  Why does this option exist? 
One reason is because it makes viewing and opening citations much easier, especially 
if your system has a large number of citations.  It also allows you to find a specific 
citation, or several specific citations, without having to wade through a long list of all 
available cites.

Ascending and Descending.  Take a moment to look at the headings for each column, 
particularly Cite #, Citation Date, Court, and Violator Name.  Next to each heading are 
two arrows.  These are used to sort the citations by a particular category in ascending or 
descending order (note that you can only order them by one column at a time).  See 
Fig. 5.14 and 5.15 for examples.

Fig. 5.14

Fig. 5.14 shows the citation list sorted by ascending Citation Date.  Fig 5.15 below, by 
contrast, shows a descending Citation Date.

Fig. 5.15

To change the order for any given column, simply click on either arrow in the column 
heading.

Print.  This function conveniently allows you to print one or more citations directly to a 
printer without having to open the citation in the Traffic Management System and then 
select print.  In the print column, simply check the box for the citation you want to print 
(and if you want to print more than one, check any additional boxes). Next, click on the 
Set link at the very bottom of the print column. The Set link will open a confirmation 
screen (Fig. 5.16 below).
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Fig. 5.16

Use the available options either to print the citation or to print the citation and any 
corresponding officer notes. The system will then display a print preview, showing you 
how the citation will look when it prints.

Fig. 5.17
(This is a detail of the print preview; the actual
print preview shows the complete citation.)
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When in print preview, you can print the citation by opening the File menu in the 
browser (at the top left) and selecting Print...  A print dialog box will open; make sure 
that the correct printer is selected and then hit the Print button.

When finished, hit the Back button on your browser.  This will take you to the Print 
confirmation screen.  You can click on the Go Back link to return to the list of citations.

Del (Delete).  The next option in the citation list screen is the Del button.  Each citation 
will have a red X in the Del column; this button allows you to delete the citation entirely 
from the system.  Deleting removes it completely, and the citation is not recoverable, so 
to ensure against accidental deletion, you will be asked to confirm your choice.

Fig. 5.18

Select Yes to delete the citation or No to return to the citation list.

NCATS.  The last option in the citation list screen is for NCATS.  This feature will send 
citation data for each citation to the NCATS database.  It’s a fast, easy, convenient way 
to transfer data from your individual workstation to the NCATS system.

First, find the citation you want to send to NCATS.  In the NCATS column, you will see 
the Send? link.  Click on the link.  You will be prompted to confirm your decision.

Fig. 5.19
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If you are certain that you want to transfer the citation to NCATS, just hit the Send 
button.  After the data has been sent, you will see a message alerting you that the data 
was successfully inserted in the NCATS database (if something went wrong, you will 
see an error message; if that occurs, contact your system administrator).

Step Seven: Opening a Citation
Syncing citations is more than simply placing them into the database.  Once they are in 
the Traffic Management System, the citations can be viewed, edited, stored, re-sent to 
NCATS, and even off-loaded to the courts.  We will deal with the various features of the 
Traffic Management System in later chapters; for now, let’s just look at how to open a 
cite.

In the list of citations, find the one you want to open.  If you move your mouse cursor 
across the screen, the “active” citation (the one that your mouse cursor is currently on) 
will have a yellow background.

Fig. 5.20

Click once to open the citation record.  The system will open the citation in standard 
data-input screens, as shown in Fig. 5.21.

Fig. 5.21
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The sync process has placed all of the citation data in the appropriate fields, and the 
citation information itself has been separated into separate pages (each of which can be 
seen by using the tabs at the top of the page. For more information on navigating in the 
Traffic Management System, please consult Chapter One).

Once a citation has been opened, it can be viewed, edited, updated, and printed. For 
information on how to work with citations in the Traffic Management System, please 
consult Chapter Six.

5.6 Opening and Viewing Collision Reports

After syncing your collision reports, you can open and view them, as well as print, edit, 
submit, review, and approve them.  To begin, exit the Sync screen and return to the 
Traffic Management System Main Menu.  Select Collisions, and when the Collision 
Menu opens, select Open Collision.

The Collision List will appear, displaying existing collision records.

Fig. 5.22

The Collision List screen has a variety of convenient features, which we will examine 
one by one.

Occasionally, the Collision List might not display collision records when you first open it.  
If this happens, use the Show Last option (which is explained below) to view records 
within a specific time range.
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Squad Code.  At the top left of the screen, just below the Crossroads Software logo, is 
a drop-down list that allows you to filter collision reports by squad code.  When you 
open the list and select a code, the system will bring up collision reports that correspond 
with that code only.  All others are excluded.  This is a helpful tool that will help you find 
and identify specific types of collision reports, without forcing you to wade through all 
the reports in the system.

Note that the Squad Code feature is an NHP-only feature; it will not appear in the 
Collision List for other agencies.

Officer.  Like the Squad Code list, this field allows you to filter collision reports.  By 
selecting an officer name from the list, you will see only those reports that correspond 
with that particular officer.

Report # Filter *.  This convenient field lets you filter collision reports by report number.  
You can enter an entire report number, or you can use a truncated number, followed by 
the wild-card character (*), to find all collision reports that begin, end with, or include 
that number.  For example, CR* will display all collision reports that begin with CR.  *CR 
will display all reports that end with CR.  And *CR* will find any reports that have CR in 
them.  Use as few or as many letters and numbers as you need.

Show Last.  The series of radial buttons here allows you to look at collisions for a 
certain time range: 1 Day, 3 Days, 7 Days, 2 Weeks,  Month, or All.  Why does this 
option exist? One reason is because it makes viewing and opening collisions much 
easier, especially if your system has a large number of collisions.  It also allows you to 
find a specific collision, or several specific collisions, without having to wade through a 
long list of all available records.

When you select one of the Show Last options, the screen will automatically refresh and 
display the results.

Ascending and Descending.  Take a moment to look at the headings for each column, 
particularly Accident Report, Collision Date, Officer ID, and Event #.  Next to each 
heading are two arrows.  These are used to sort the collisions by a particular category in 
ascending or descending order (note that you can only order them by one column at a 
time).  Simply click on one of the arrows, and the system will place the records in 
appropriate order.

Fig. 5.23 on the following page shows the CollisionList by descending Accident Report 
#.
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Fig. 5.23

The descending arrow turns red, and the accident report numbers are listed in 
descending alphabetical and numerical order.

Fig. 5.24 below shows collision reports ordered by ascending date.

Fig. 5.24

Note that the ascending arrow is red, and the dates run from earliest first, through the 
latest at the bottom of the list.

Delete?  This option in the Collision List allows you to delete a collision record entirely 
from the system.  To delete a record, simply find the record in the list and click on the 
Delete? link in the same row of that record.

Choosing to delete a record will remove it completely, and the collision will not be 
recoverable.  To ensure against accidental deletion, you will be asked to confirm your 
choice with this message: Do you want to delete this collision record?  The message 
will also display the record number.  Select “Yes” to remove the collision, or select “No” 
if you decide you want to keep it.

158



Status.  The Status field actually performs two functions: 1) it displays the current status 
of each collision record, and 2) it allows users to submit records for review.  The two are 
directly related, so let’s look at how the submit and review process works.

5.7 Submit, Review, and Approve

Follow the steps below to submit, review, and then approve collision records.

1. When a collision record is synced into the Traffic Management System for the first 
time, it is labeled “New” in the status field of the Collision List screen.

The record needs to be submitted for review.  To do this, click on the icon in the status 
field next to the record’s status (where it says “New”).  (Note: make sure you click on the 
icon, not the record itself.  If you click on the record, the entire record will open.  Instead, 
you want to open the submit screen).

Fig. 5.25 shows the submit screen.

Fig. 5.25

In the submit screen, the user can insert comments if necessary.  Click the Submit 
button to submit the record for review.

2. When the record is submitted for review, the status in the Collision List  then reads 
“Submitted,” and the collision can be edited by the originating officer.

The officer can now click on the record itself and review it.

3. Once the record has been submitted, there are two options: the submission/review 
can be cancelled, in which case the record returns to its “new” status.  Or it can be 
accepted for review, to be looked at by an administrator or approving officer.  In this 
state, the status will read “In Review.”

Fig. 5.26
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4. While it is under review, the record can then be handled in one of two ways. If the 
approving officer feels that no additional changes need to be made, the record can be 
approved (to do this, simply hit the Approve button in the Submit Screen.  The button is 
available only after the record has been accepted for review).  The status will read 
“Approved,” and the record has been finalized.  However, if the approving officer feels 
that some change(s) needs to be made, he or she can request changes.  Fig. 5.27 
shows the submit screen when additional changes are requested.

Fig. 5.27

Write comments in the Comments field if necessary.  When ready, hit the Request 
Change button.

Of course, if there are no changes to request, just hit the Approve button to approve and 
finalize the collision record.

5. The Request Change button will open a special notes section, in which you can 
specify what needs to be changed for each field.  The Notes screen (Fig. 5.28) 
organizes all the data fields by collision report pages; so, for example, there are 
separate sections for the fields for the scene information page and for the vehicle page.

Fig. 5.28 on the next page shows a sample Notes screen.
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Fig. 5.28

Scroll through the page to find the data fields that need to be changed.  Enter 
instructions, corrections, or notes about changes in the text field(s) on the right.

Here’s a sample of notes for two fields:

Fig. 5.29
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Once all the necessary notes have been entered, click the Add Notes button at the top 
of the screen.  This will save the notes, allowing them to be displayed in the record 
itself.

The Collision List appears, and the record is highlighted in red, with  the status now 
reading “Change Request.”

Fig. 5.30

Clicking on the status icon will open the submit screen (Fig. 5.27), where the user can 
read comments about the record.

Selecting the record by clicking on its number in the list will open the record.  Yellow 
“sticky” notes will appear at the fields that need to be fixed or changed, along with the 
notes that were created in the Notes screen.

Fig. 5.31

In this example, the note for the city name appears next to the City field, while the note 
for the surface type correction appears next to the Surface field.  The red arrow at the 
top of each note will collapse the note so that you can see more of the field; clicking the 
arrow again will expand it.

Make the correction in each field, and then hit the X in the top right of each note to close 
it.
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When the changes are finished, click the Save/Update button at the top of the screen.

Fig. 5.32

The Save/Update button is the one in the center with the disk drive icon.

6. When you save the record, four options will appear: Open Same Collision, Open 
Other Collision, New Collision, and Collision Menu.  Select the option for the task 
you want to do next.  The status of the collision record you just edited and saved will 
remain as “Change Request” until it is submitted to the approving officer.

Return to the Collision List and select the status icon to open the status screen for that 
record.  Write in any necessary comments (such as “changes made according to your 
notes”), and then select the Submit button.

This will change the record’s status to “Submitted”.  The approving officer can then look 
at the record again and approve it or re-submit it for further changes.

If no other changes are necessary, the record can be approved by selecting the 
Approve button.

7. During the review process, you will have two options for data validation.  In an open 
collision record, the Validate button is next to the Save/Update button; it’s the button 
with the checkmark in Fig. 5.32.  In the submit screen (depending on the stage of the 
review process), you’ll see an Accept for Review and Validate button.  Both buttons 
open a list of errors and warnings that should be fixed or looked at before final approval 
(the System checks the entire collision record and then flags any errors or warnings).

Fig. 5.33 on the next page show a sample Collision Validation Errors list.

Errors are the most critical items, while warnings are important but less critical (and 
some may not need to be addressed in every instance).
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Fig. 5.33

Use this list as your guide for fixing errors and making any changes suggested by the 
warnings.  When you have finished, simply hit the Save/Update to save the record.

8. Once the all of the changes have been made, the record status stays at “Change 
Request”.  To make the record ready for approval, it needs to be re-submitted to returns 
to “Submitted” status.  This allows the officer to write in a comment about whether or not 
the requested changes have been made.  The record then has to be looked at again by 
an approving officer, who can re-submit it by selecting Accept for Review in the submit 
screen (and by adding any additional comments).  The status will then change to “In 
Review.”

Once the record in review, it can be approved (by using the Approve button in the 
submit screen).

If this submit, review, and approval process seems confusing, here’s a basic flow chart 
that illustrates how the process works (Fig. 5.34).
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Fig. 5.34

When reviewing collision records, keep in mind that they can be changed until you hit 
the Approve button. Once a record has been approved, it cannot be changed (in the 
Traffic Management System, the “save” option for approved records is disabled).

If there are changes that need to be made to an approved collision record, the officer 
needs to file a supplemental report.

We have covered submitting and reviewing, but, of course, editing records is also an 
important part of the entire process.  Please continue with the next chapter to learn how 
to open, view, edit, and save records in the Traffic Management System.
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CHAPTER SIX

OPENING AND EDITING RECORDS

In the previous chapter, we looked at syncing citations and collisions with the Traffic 
Management System.  Now we are going to look at how users can open, edit, and save 
those records.  Once records have been synced with the Traffic Management System, 
they are meant to go through a process of reviewing, editing, approving, submitting, and 
so on, and opening and editing records is an important step in this process.  Let’s see 
how it’s done.

The steps in opening and editing traffic records, whether they are citations or collisions, 
are the same, so for simplicity’s sake we’ll just look at one type of record: the collision 
record.

The first thing to do is access the Collision Menu from the Main Menu.  In the Main 
Menu, select Collisions (if you are opening and editing citations, then, obviously, you’d 
select Citations instead).

The Collision Menu will open.

Fig. 6.1
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Select Open Collision from the Collision Menu.  The Collision Records List will open.

Fig. 6.2

The Collision List will display records that have already been synced into the system, as 
well as the status of those records.  There are a number of options for searching, 
sorting, and displaying collision records in this List.  To learn about these options, see 
Chapter Five, Section 5.2, Step Seven.

To open a collision record so that it can be viewed and edited, simply locate the record 
in the list and click on it.  There might be a slight delay as the System pulls the record 
up.  The collision record will open in the standard collision form screen:

Fig. 6.3
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All of the existing data will appear in their proper fields (for example, the occupant’s 
name will appear in the name fields, the street on which the collision took place will 
appear in the Collision Occurred On field, the date, time, and day of week will be in their 
respective fields, and so on).  If a field is empty, it means that the officer who originally 
filled out the collision report left that field blank.

Editing the data in a collision record is a very easy, straight-forward process.  
Essentially, you locate the data you want to change within the record and then, using 
the keyboard and mouse, you simply remove or alter the existing data.  If the data is in a 
text field, you can highlight and delete the text and then enter the correct data.  If the 
data is in a drop-down menu, simply open the menu and select a different entry.  Or if 
the data is in a check-box, simply check the correct box.  Editing information in a 
collision record is a just like changing data in any regular Windows-based program.

Let’s take a look at a few examples.

Here, the road surface type needs to be edited.  In the existing record, the Surface field 
was marked like this:

Fig. 6.4

To remove the check next to Asphalt, you’d simply click in that check-box once with the 
mouse -- or, if you are using the keyboard, you would hit “A” (the underlined letter of 
each entry corresponds with the key required to check or uncheck it).

Fig. 6.5

The background changes color because Surface is now the active field.
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Finally, check the box next to the appropriate Surface type (or use the keyboard to 
select the letter that corresponds with the right type).

Fig. 6.6

The Surface type has now been changed.

Editing data in other fields is just as easy.  For example, if you need to edit a street 
name in the Collision Occurred On field, you would simply click in the field, highlight the 
street name, and then delete it.

Fig. 6.7

Then you would write in the correct street name.

Fig. 6.8

What about data that is contained within a drop-down list?  Can that be edited too?  
Quite easily actually.  In a field that contains data that was selected from a drop-down 
list, editing is simply a matter of re-selecting data.  Take a look, for example, at the 
Violation Description field.

Fig. 6.9
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Open the drop-down list to see other available data.

Fig. 6.10

Select a new entry from the list.  The drop-down menu will close, and the new entry will 
appear in the field.

Fig. 6.11

You use all of these editing methods to change or remove data in collision and citation 
records.  Remember to use the tabs at the top of the screen to move from one section 
of the record to another; for example, in a collision record, you will see tabs marked: 
Scene Info, Vehicle 1, Vehicle 2, and so on.

Editing Dates and Times
Changing the date or the time in a collision or citation record is something you may not 
need to do often, mainly because the date and time are automated on the handheld 
units; this means that synced records will most likely have a correct date and time.  But 
there are reasons why the date or time might need to be edited: if the officer in the field 
manually changed the date or time and input incorrect data; if the handheld unit had the 
wrong date and time in its operating system; or if a collision or citation records was input 
by hand in the Traffic Management System.

Editing the date and time is as easy as selecting it, highlighting it, and then writing in the 
correct data.  Let’s see how this is done by changing the date field.
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First, select the date field you wish to edit by clicking it with the mouse or navigating to it 
with the Tab key on your keyboard.

Fig. 6.12

Highlight the existing date.  If you are using the Tab navigation, the System will 
automatically highlight the date for you.

Fig. 6.13

Delete the date by hitting the Backspace or the Delete key.  Then, type in the correct 
date.  The system will automatically fill in the slashes between the month, day, and year.

Fig. 6.14

When you are finished, the new date will appear, and you will be moved to the next data 
field.

Fig. 6.15
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The Most Important Step
After editing a record, it is crucial that you update the record so that your changes will 
be entered in the database, and the modified record will be available, as opposed to the 
older, incorrect one.  To do this, hit the Update button at the bottom of the record 
screen.

Fig. 6.16

The Exit button will close the current record, but will not save any of your changes.

When you update the record, a confirmation screen will appear, giving you several 
options.

Fig. 6.17

The System will tell you if the record was successfully updated.  The options include: 
Open Same Collision, which will, of course, re-open the record you just edited if you 
want to view it again or make further changes; Open Other Collision, which will return 
you to the Collision List so that you can select another record; New Collision, which will 
open a blank collision form; and Collision Menu, which will return you to the menu with 
all the collision options.
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Adding Data and Sections to a Record
Editing a record is more than just a matter of changing or deleting existing data.  You 
can also add data.  If specific data in a record was accidentally omitted, but you have 
the data and know it was supposed to be inputted, you can input it by any of the 
methods used for entering data (writing data in a blank field, selecting data from a drop-
down list, marking a check-box, and so on).

In addition, you can also add a section to a record, such as another vehicle section, or 
perhaps a non-motorist or a narrative form.  To add a section, use the navigation 
buttons at the top of screen to select the section you need (see Fig. 6.18 below).

Fig. 6.18

The four graphical buttons on the left represent specific record sections (just hover the 
mouse cursor over each one for a second or two, and a description will appear).  In a 
collision record, the sections are: Vehicle, Non-Motorist, Occupant/Witness, and 
Narrative.  Citation records are complete and don’t allow the addition of more sections 
(a citation is a single, whole entity, whereas the number of forms in a collision record will 
vary depending on the specifics of each collision).

Simply click on one of the buttons to open a new form.  For example, selecting the 
Occupant/Witness button will open a new Occupant/Witness form, as shown in Fig. 6.19 
below (the figure is just a detail of the form, not the complete thing).

Fig. 6.19

When the new section opens, begin inputting data as if you were writing a new report 
(for more information on inputting data, consult Chapter One).  When finished, make 
sure to hit the Update button to save the entire record.

These, essentially, are the steps for opening and editing records in the Traffic 
Managements System.  Continue to the next chapter to learn about running queries.
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CHAPTER SEVEN

QUERIES

Traffic and citation records input and management are an integral part of the Traffic 
Management System.  Equally important is the ability to query those records and run 
reports.  The analytical capability of the Traffic Management System allows agencies to 
go beyond the input, storage, and management of information, to a point where they 
can use that information to understand where, why, and how violations and collisions 
occur and to take steps towards minimizing traffic problems.

The Queries section of the Traffic Management System offers a wide variety of queries 
and reports for citation and collision data, in addition to charts, officer activity reports, 
and GIS mapping options.  For example, you can run a historical report for all collisions 
at a specific intersection during a specific time period, and then have the results of that 
report appear in a GIS map.  Or you might run a report that breaks down citations by 
day and time.  There are numerous options at your disposal.

This chapter explains how to run the various citation and collision queries in the Traffic 
Management System.

NOTE: Each query is defined in this chapter, but because many of the queries 
operate the same way, we won’t look at each and every one in depth.  Once 
you have learned how to run a specific type of query, all others of that type 
will run the same way.  We will however, explain each type of query 
thoroughly, and note any differences or unique features that you should be 
aware of.

7.1 Accessing the Queries

To access the Queries, simply click the Queries link in the Main Menu of the Traffic 
Citation Management System.  The Queries and Report Menu will open (Fig. 7.1 
below).  The menu contains links to sub-menus that contain specific query and report 
options.
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Fig. 7.1

Collision Queries.  For these queries, refer to section 7.2.

Citation Queries.  If you want to run citation queries, please see section 7.10.

Charts.  To produce graphs and charts, consult section 8.1.

Officer Activity Reports.  Details about these reports can be found in section 8.2.

Records Output.  Find out about this option in section 8.3.
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7.2 Collision Queries

The Collision Queries Menu contains all the available collision-based queries and 
reports.

Fig. 7.2

The collision queries include:

General Query. Run a query for all collision data in the database; you can limit the 
search using a wide variety of parameters, ranging from day and time, city, intersection, 
highway conditions, vehicle factors, and more.

Collisions By Day and Time.  Queries a specific intersection for the number and types 
of collisions by day and time.  This query includes a number of parameters to help limit 
the search.

Intersection High Incidence.  Ranks a specific number of intersection locations by the 
frequency of collisions, from high to low.
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Midblock High Incidence.  Ranks a specific number of mid-block locations by the 
frequency of collisions, from high to low.

Intersection Historical.  This query produces a historical report for a specific location, 
over a specified period of time.

Midblock Historical.  Performs the same query as the intersection historical, but in this 
case it queries on a mid-block segment, instead of an intersection.

Collisions by Injury.  Calculates the number of collisions per injury type for a specified 
time period.

Collisions by Injury Severity.  Ranks collisions by the degree of injury, from fatal (as 
the highest), through Incapacitating, Non-Incapacitating, No Injury, and down to 
Unknown.

Driver Breakdown Factor.  This report calculates the number of collisions and vehicles 
according to the condition of the driver.  For example, factors include Had Been 
Drinking, Drug Involvement, Apparently Fell Asleep, Obstructed View, and more.

Parties at Fault by Age.  After specifying a date range, you can find out how many 
parties are at fault for reported ages.

Vehicle Factor Breakdown.  A thorough query that displays the number of collisions 
and vehicles according to specific vehicle factors.  These factors include Fail to Yield 
Right of Way, Exceeding Speed Limit, Mechanical Defect, Hit and Run, and a number of 
other factors that relate to collisions.

Traffic Collision Log.  Produces a readable, informative log for all reported collisions 
that occurred during a specified date range.

Data Entry Stats.  Provides a statistical summary of the time it took to input traffic 
records; also includes total records, shortest and longest time, and average time. 

Data Entry Stats Summary.  Provides a statistical summary of the time it took each 
user to input traffic records.

Collision Lookup.  A very usable feature that allows you to lookup collision records by 
dates, collision number, and most helpfully, by person.
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7.3 How to Run a Query

As mentioned previously, most of the collision queries work the same way.  Because of 
this, we will use a couple of queries as examples; with these examples, you can learn 
how the queries operate and then go on to run as many as you need.

For the first example, we will use the Collisions by Injury query.

Fig. 7.3

The first thing you’ll notice is that there is a variety of query parameters.  These 
parameters allow you to widen or narrow the amount of data -- and number of collision 
records -- that you search.  For example, if you enter a date range and specify no other 
parameters, the query will return all collision records within that range.  However, if you 
then specify a highway factor, light conditions, and roadway conditions, the query will 
return only those collisions that meet those specific factors.

The query paramaters are divided into two sections: “Main,” which includes either 
necessary ones or those that you will probably use most often, and “Additional,” which 
includes a larger set of various querying factors.
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Main Query Parameters
The most important parameters are the Start Date and End Date because every query 
requires a date range.  By default, the query automatically includes start and end dates 
that have been set up in the Traffic Management System Configuration -- in other 
words, default dates intentionally set for the queries.

You can change the start and end dates. Simply click in the start or end date field and 
enter a new date.

City.  With this option, you can query collisions that occurred in a specific city.  Open the 
list to select a city.  If you leave this option alone (set to *), the system will include 
collisions in all cities.

Intersection Related.  When set to “yes,” the query will include only those collisions 
that are intersection related; in other words, collisions that occurred within fifty feet of an 
intersection, as well as rear-end collisions heading towards the intersection within 150 
feet of that intersection.

If you select “no,” the query will exclude intersection related collisions.

By default, this option is set to *.  This simply sets the query so that it makes no 
distinction and includes matching citations that are intersection related as well as non-
intersection related.

Select the Streets.  If you want to query a specific location, you can select a primary 
road (or street) and a secondary road (cross street).  First, open the Street list to select 
a primary road.

Fig. 7.4
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To input the street, just click on it with the mouse.  In this example, we’ll select Main 
Street.

Once you’ve selected the primary road, the system fills in the Cross Street list with 
those roads that cross the primary road -- a very convenient feature that doesn’t force 
you to scroll through an entire list of city streets and guess which ones cross.

Open the Cross Street list and select a secondary road.

Fig. 7.5

Now, both streets have been selected:

Fig. 7.6
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NOTE: Most of the collision queries do not require you to specify an 
intersection.  The streets lists exist in the event that you want to query only 
one location, but if you want to query all locations, you can; simply leave the 
streets fields empty (i.e. leave the * in the fields).  There are, however, a 
couple of collision queries that do require a specific location because they are 
location-based queries.  These are the Intersection Historical and the 
Midblock Historical.

Additional Query Parameters.  The bottom section of the query has a series of 
parameters that help you narrow the query to obtain more specific collision results.  The 
majority of the collision queries have the same Additional Query Parameters, and they 
all work the same way: drop-down lists from which you can select specific factors.

For example, let’s say you need to run a query for all collisions that are head-on 
collisions.  Open the Vehicle Collision Type list, find Head On, and select it with the 
mouse.

If there are other query parameters that you want to query by, such as light or weather 
conditions, simply use those lists to make your selection.

Finally, you can also input a Start Time and End Time to query only those collisions that 
occurred within the specified time frame.

By default, all of the Additional Query Parameters are set to *, meaning that they 
automatically include all collision types, all locations of first event, all highway factors, 
and so on.  This provides you with the widest possible query for the date range you 
specify in the Main Query Parameters.

Fig. 7.7
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When You Are Ready to Run the Query
Here comes the easy part: when you’ve input a date range, selected streets (if 
applicable), and selected query parameters (if applicable), just hit the Run Query button 
at the top right of the query screen.

The system will query the database and display your results in a readable and printable 
report.  Fig 7.6 below shops a sample Collisions By Injury Report.

Fig. 7.8

Reading the Report
The report contains several points of information.  At the top is the heading, which 
denotes the agency name and the type of report.

Below that is the Date Range Reported; in other words, the start and end dates used in 
the query.

The main body of the report contains the query results.  For Collisions by Injury, there 
are two columns, one for Injury Category and one for Number of Collisions.  These 
columns are followed by a tabulation of Total Victims and Total Collisions.

Finally, at the bottom of the report are the Settings Used for Query.  Any and all 
specified query parameters are listed here.  In the example above, all that is listed is the 
date range because no other parameters were set.
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However, had we set Vehicle Collision Type or Roadway Conditions, those settings 
would be listed as well.  The purpose for the Settings Used for Query is to provide you 
with a quick reference for completely understanding the results of the query, so that 
anyone reading the report can interpret the collision results accurately.

7.4 Printing the Report

Each collision report can be printed for your use, such as reviewing collisions, 
maintaining hard copy files, having readily accessible reports without running queries 
again.  Having printed reports can greatly enhance and facilitate your records 
management and traffic analysis.

NOTE: Before printing a report, it’s important to ensure that the page margins 
are set properly.  Because some of the reports are in landscape (instead of 
portrait), there is the possibility that the entire report won’t print if the margins 
are too wide.  The page margins should be set to ¼ (.25) inch on all 
sides.  To do this, simply go to the File menu at the top left of your internet 
browser window.  From the File menu, select Page Setup.  Depending on 
which browser version you are using, the location of the margin settings will 
vary; but just look for Margins and set each of them to .25.  When finished, 
click OK.  Once you set the margins, the browser should maintain the 
settings (even after the computer is restarted or shut down) until you 
manually change them again.

When you’re ready to print the report, simply go to the File menu in the browser and 
select Print.  You will have to change the page layout to Landscape (unless you have 
changed the layout already, in which case the browser should maintain your setting).  To 
do this, click on the Layout tab in the Print dialog box and select Landscape.  Then hit 
OK to print the document.
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7.5 General Query

The General Query is the most extensive collision query, offering the widest range of 
query parameters and allowing you to search all available collision data.  As with the 
other collision queries, the parameters exist for you to include and exclude as much 
data as you want -- you can query all collisions for a specified date range, or you can 
limit the search.  For example, you might want to produce data for collisions that 
occurred at dusk on rainy days and that involved side-swipes.

You cannot get as specific as, say, searching by the middle name of the third passenger 
of the second vehicle of a particular collision (now, that’s specific!).  Nevertheless, the 
General Query’s options are incredibly extensive, offering most of the parameters used 
for categorizing collisions (and, in addition, queries are not for single-collision reporting 
anyway; their main purpose is to understand collision patterns over time).

Sections of the General Query
The Query itself comprises a series of sections offering various query parameters.  Let’s 
look at these sections one by one.

Day and Time

Fig. 7.9

The Start Date and End Date are just what they seem -- the beginning and end of the 
date range you wish to query on.  You can specify days, weeks, months, a year, or 
several years.  By default, the Start and End Date fields include the dates originally set 
up in the Queries and Reports Configuration option (which itself is in the Setup Menu).  
You can change the dates by clicking in the fields and writing in new dates, or by going 
into the Queries and Report Configuration (which will change the Start and End Dates 
for all queries and reports).

Next, there are fields for Start Time and End Time.  So, for example, you might want to 
query all collisions that occurred between 5:00 AM and 8:00 AM.  To do so, you would 
simply write in the beginning and end times.
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If you would like to run queries for collisions in a specific city in the county, just open the 
City drop-down list and select the city name.

Select the Streets

Fig. 7.10

Selecting street names in the General Query works the same way it does in other 
queries (which is a good thing -- can you imagine a program in which a particular 
feature worked differently each time?).  The details for selecting streets are covered in 
Section 7.3, but we’ll go over them (briefly) again.

First, there’s the Intersection Related field, which, by default, makes no distinction 
between intersection and non-intersection related collisions (it includes them all).  Select 
“Yes” to query only intersection-related collisions or “No” to query only non-intersection 
related collisions.

Next, select the primary road from the Street drop-down list.  When you have selected a 
street, the System automatically locates all the streets that cross that primary arterial 
and puts those streets in the Cross Street field.

Now, open the Cross Street field and select the secondary road.

Just remember that you do not have to query by a specific location.  You can query by 
all locations if you’d prefer (and this is the default setting anyway).

Conditions
The Conditions section (Fig. 7. 11 below)  includes drop-down lists for a variety of 
conditions-related parameters, including Highway/Environment Factors, Light 
Conditions, Weather Conditions, Roadway Character, and more.

You can leave them all set at default (*), in which case the query won’t limit results 
according to specified conditions.  But you can specify conditions if you are querying for 
collisions that meet certain factors, such as those that occurred at dusk or those that 
occurred on icy roads (or both).  You can set as many conditions parameters as you 
need.

To do so, just open a drop-down list and select the appropriate condition by clicking on 
it.
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Fig. 7.11

Once you have finished with the Conditions section, move on to Vehicle and Driver 
Information.

Vehicle and Driver Information

Fig. 7.12

The General Query is the only major collision query that contains parameters for vehicle 
and driver information.  The drop-down lists in this section allow you to query by a 
variety of factors, which include:

Vehicle Factors: Aggressive/Reckless/Careless, Disregard Control Device, Driverless 
Vehicle, Drove Left of Center, Fail to Maintain Lane, etc.

Driver Factors: Apparently Fatigued/Asleep, Apparently Normal, Driver Ill/Injured, 
Driver Inattention/Distracted, and more.

Vehicle Action: Backing, Driverless Vehicle, Enter Parked, Entering Lane, Lane 
Change, Leaving Lane, and similar factors.

Configuration: This list denotes the vehicle type, or vehicle configuration, including Any 
4 Tire Vehicle, Bus 9 to 15 Occupants, Bus Greater Than 15 Occupants, Light Truck, 
Light Truck Haz Mat, and more.

Occupant Restraints: Child Safety Seat Used, Helmet Used, Not Installed, Not Used, 
etc.
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Injury Severity: Claimed, Fatal Injury, Incapacitating, No Injury, etc.

Seating Position: Font Seat - Left Side, Front Seat - Middle, Front Seat - Right Side, 
and more.

Additional Parameters

Fig. 7.13

This is the final section of the General Query, and it contains two fields, one for Vehicle 
Collision Type, the other for Location of First Event.

If you wish to query by these parameters, simply open each drop-down list and select 
an applicable entry (the entries include Angle, Backing, Head-On and similar items for 
Vehicle Collision Type, Inside Shoulder, Intersection, Median, etc. for Location of First 
Event).

Run Query
When you have set the Start and End date, selected a city and streets (if applicable), 
and any parameters, you can run the query by clicking -- you guessed it -- the Run 
Query button at the top of the query screen.

Here’s a detail of the report produce by the General Query:

Fig. 7.14
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The collision summary report has a readable layout, with important data for each 
collision separated into columns.  You’ll probably notice that some of the column 
headings have multiple listings -- Distance and Direction, for example, or Vehicle Factor 
1 and Vehicle Factor 2.  This simply means that these columns will sometimes hold 
multiple pieces of information (when applicable), and that information will be displayed 
in the order of the heading.

For example, let’s say one of the query results is a collision with two vehicle factors, 
Failed to Yield Right of Way and Too Fast for Conditions.  These will be displayed like 
this:

Fail to Yield Right of
Way, Too Fast for
Conditions

Fail to Yield Right of Way is Vehicle Factor 1, while Too Fast for Conditions is Vehicle 
Factor 2. 

Printing the Report
For details on printing reports, please see section 7.4 of this chapter.
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7.6 Historical Queries

There are two historical collision queries, the Intersection Historical Query and the 
Midblock Historical Query.  Both allow you to produce historical reports for a specific 
location during a specific period of time.

Like all other collision queries, these historical queries can be set to include as much 
collision data as possible in the query, or they can be set to narrow the results.  So, for 
example, you can run a historical query for all collisions that occurred between January 
and June 2003.  But you can also run a historical query for all collisions that occurred on 
icy roads between 6 AM and 9 AM between the dates of November 1, 2003 and January 
31, 2004.  In other words, the queries are quite flexible.

These queries also work in conjunction with GIS mapping; they can create electronic 
GIS maps that display the query results.  We’ll look at GIS mapping in detail in the next 
chapter.  For now, we’ll just focus on how to run these historical queries.

Both queries work the same way as all other collision queries.  In other words, there are 
Main Query Parameters and Additional Query Parameters.  We won’t cover every detail 
of the historical queries, only those portions of it that differ from other collision queries (if 
we did, this user’s manual would be even longer!).  For instructions on “How to Run a 
Query,” see Section 7.3  Once you have consulted that section and know how to run 
queries, you can continue with the historical queries.

Streets
In most collision queries, you have the option of select a specific location or letting the 
query search all locations.  But with the Intersection Historical and Midblock Historical 
Queries, you must select a location.  Why?  Because these queries are made only for a 
specific intersection or midblock segment.

If you run the query without selecting any streets, you will get this message: “You must 
enter Street Names for both Primary Road and Secondary Road” (for the Midblock 
Historical Query, the message reads: “You must enter Street Names for a Street and two 
Cross Streets”).

Selecting streets in the Intersection Historical Query works the same way it does with 
other queries: open the Street drop-down list, scroll through the list until you see the 
street name you want, and select it by clicking on it with the mouse (Fig. 7.15 below).
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Fig. 7.15

It’s not absolutely necessary to select a street with the mouse.  If you prefer, you can 
also use the keyboard.  The streets are listed alphabetically, so hitting specific letters on 
the keyboard can take you to the first street in the list that begins with that letter.  For 
example, let’s say you want to find Lamoille Highway.  Hitting “L” on the keyboard will 
take you to the streets that begin with L.  Then use the arrow keys on your keyboard to 
navigate through the list until you find Lamoille Highway.

With the primary road selected, open the Cross Street drop-down list to select the 
secondary road.

Fig. 7.16

Once you’ve selected a primary road, the System fills in the Cross Street list with those 
roads that cross the primary road -- a convenient feature that doesn’t force you to scroll 
through an entire list of city streets and guess which ones cross.
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GIS Mapping
At the bottom of each historical query is a checkbox with this label: “GIS Map. Click here 
if you wish to create a GIS shapefile.”

This option creates a GIS shapefile of the query results, allowing you to view the 
collisions on a GIS map.

When You Are Ready to Run the Query
At the top of the query form you’ll see two buttons: one marked Intersection Collision 
Diagram, another marked Run Query.  Let’s take a look at the Run Query button first.  It 
essentially produces a report based on your query parameters.

Fig. 7.17

Each collision record has its own row in the report, with the data for each collision report 
arrange in columns.  Column headings at the top tell you what type of data is listed 
(e.g., Report Number, Collision Time, Direction, Involved With, and so on).  Basic report 
information is contained at the top left of the report, where you can see the location, 
date range, and the total number of records for that location and time period.  The 
bottom of the report (not shown here) contains information about all of the settings you 
specified for the query.  Therefore, if you set any of the additional query parameters, 
those settings will be displayed at the end.
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The Intersection Collision Diagram is a different type of report altogether.  It will show all 
the collision records that match your parameters, but it will present them in a clear, 
color-coded diagram that shows direction of travel and collision type.  Fig. 7.18 below 
shows a detail of Collision Diagram.

Fig. 7.18

Each collision record is represented by a set of symbols comprised of arrows and other 
signs and by basic information, such as date and collision factor.  The colors represent 
the severity of injury, while the arrows and others symbols signify the type of collision.  
You can use the legend at the bottom of the page to read the diagram.

Fig. 7.19
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Using the legend at the bottom, you can view the Collision Diagram and the collision 
patterns on your computer screen.  If you wish, you can also print the Diagram to a 
color printer.  While in the browser, open the File menu at the top and select Print.  A 
print dialog box will open; make sure you have the right printer selected, and then just 
hit Print.

With most browsers and printers, the margins might be set to one inch (or more) on all 
sides.  In order to get the Diagram to fit a single page, you’ll have to set your margins to 
a quarter inch (.25) on all sides.  To do so, open the File menu and select Page Setup.  
In the bottom right of the Page Setup box you’ll find the margin settings.  Input .25 into 
each field and then hit OK.  If you want to see how the new settings look before printing, 
select Print Preview from the File menu.

To return to the Intersection Historical Query, just hit the Back button on your browser.

We won’t look at some of the remaining Queries (Midblock Historical, Collisions by 
Injury Severity, Driver Factor Breakdown, and others) because they all operate the 
same way as the queries we’ve looked at (although, just remember that with the 
Midblock queries, you need to pick two cross streets as opposed to one).  Instead, let’s 
move ahead and take a look at a few queries that are somewhat different.

7.7 Traffic Collision Log

The Traffic Collision Log is one of the easiest queries to run.  Why?  Well, it  only 
requires a date range!  And if you have already set up the date range you want to query 
by in the Configuration section of the Traffic Management System, then you won’t even 
need to input new dates -- all you’ll have to do is hit the Run Query button.

Pretty easy, isn’t it?

Of course, you can query by any date range you wish.

Fig. 7.20

Set the collision dates and hit Run Query.
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Fig. 7.21

The Collision Log is a simple, useful report that shows you all of the citation records for 
the date range you selected.  That date range is shown at the top, while the bulk of the 
report consists of a tabular log displaying all of the collision records, each in its own row 
with the following relevant information (with the proper headings at the top): Accident #, 
# Injured, Collision Type, Vehicle Driver Factors, Time, Date, Location, Officer, and 
Cited (which indicates whether or not the driver was issued a citation).

The sample above is just a detailed section of the Collision Log report.  Depending on 
the date range you input and the number of records in your system, the report might be 
much longer -- and in some cases, it might be much shorter.

To print the report, go to the File menu in your browser and select Print.  The report 
might not fit the margins or the layout of your current printer setup.  To see if it does, just 
select Print Preview in the File Menu.  In the event that you need to change the margin 
settings or the layout, use the Page Setup option in the File menu, make the 
appropriate changes, and select Print.

Continue on to Section 7.8 to learn about Data Entry Stats.
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7.8 Data Entry Stats and Data Entry Stats Summary

A very useful feature of the Traffic Management System is the ability to run statistical 
reports on the entry of collision records.  This allows your agency to understand how 
many records have been entered over a specified period of time, the average time it 
takes to enter a record, and the longest and shortest times for record entry.  You can 
also see similar statistics for each user.

There are two data entry reports: Data Entry Stats and Data Entry Stats Summary.  The 
first includes a run-down of data entry stats and then information on each collision 
record entered.  The Summary report is different: it shows data entry stats by user.

To run either query, all you need to do is input a date range, and you don’t even need to 
do that if you’ve set the date range you want in the Configuration menu of the Traffic 
Management System (of course, even if you have set the dates in Configuration, you 
can still change them when you open the query form).

Make sure you have the date range you want and then select Run Query (the Reset 
Form button will return you to the default date range if you have changed the dates).

Fig. 7.22

When you run the query, the report will look similar to this one:

Fig. 7.23
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At the top of the report are stat totals for the date range you queried.  On the left, you’ll 
see that the report shows the Longest time it took to input a record, the Average time it 
took, and the Shortest time.  This information will help your agency get an accurate 
sense of the efficiency of traffic records entry.

On the right, the report shows the Total Time spent inputting all the records that are 
currently in the System.  The report also shows the Total Reports that are in the 
System, as well as that total times the minimum number of hours.

Below these stats is a table of all the collision records in the System, with each record 
displayed in a row.  The table displays five types of relevant information: Entered By 
(who input the record), Collision Number, Entry Started (when the record first started 
being entered), Entry Completed (when the record was finished), and Elapsed Time 
(obviously, how long it took to complete the record input).

The purpose of the Data Entry Stats report is to show and analyze how quickly records 
are being inputted into the System and how many personnel hours are being spent on 
records input.  These stats can be useful in determining records management efficiency 
and allocation of agency resources.

To run the Data Entry Stats Summary, you essentially do the same thing as you did 
with the Data Entry Stats query: input a date range and then hit Run Query.  The 
Summary report is different:

Fig. 7.24
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Like the first Data Entry Stats report, the Summary report displays the total statistics for 
records input at the top (Longest, Average, Shortest, Total Time, Total Reports, and Total 
x Minimum) but the results in the report table are different.  Essentially, the Summary 
displays statistics for each user, with the user’s ID listed in the Entered By column.  It 
then shows the Shortest amount of time it took each user to input a record, the 
Longest amount of time it took that same user to input a record, and the Average time 
it takes for that user to enter a record.

In addition, the Summary also displays the Total Reports entered by each user and the 
Total Hours each user spent inputting records.

Printing the Data Entry Reports
To print either the Data Entry Stats or the Data Entry Stats Summary report, just open 
the File menu at the top of the browser and select Print.  If the report does not fit within 
the margin, you can set the margins in the Page Setup option in the File menu.  
Remember that you can see how the report will look before it prints by using Print 
Preview.

Now that we’ve looked at the Data Entry Stats queries, let’s move on to something quite 
different: the Collision Lookup feature.

7.9 Collision Lookup

Fig. 7.25

The Collision Lookup is a powerful, useful feature that allows you to search collision 
records by person, or by particular pieces of information relating to a person. There are 
a variety of search parameters: Collision Number, Name, Street Address, Vehicle 
License Number, Phone Number, and Collision Dates.  You can search by any one of 
these parameters or by a combination of several of them.  Let’s see how this works.
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You can search by whatever criteria you have: if you want to search by a collision 
number, input that in the Collision Number field; if you want to search by a last name, 
input that; if all you have is a street address, enter that in the proper field.  You might, for 
example, want to look up all records that begin have a collision number that begin with 
“N” or that involve and individual with the last name of “Jones” -- or both.

There are two important things to remember here: the more information you put into the 
query, the narrower your search will be, which means you will get fewer results; and, 
also, you can use the wildcard feature to your advantage.

What’s a wildcard?  Essentially, it allows you to search for a range of data.  It uses the 
asterisk (*) along with letters or numbers, and where you place the wildcard and how 
many letters or numbers you use will determine the type of search results you get. 

For example, if you enter N* in the Collision Number field and then hit Run Query, the 
System will search for any and all records with numbers that begin with “N”.  If you enter 
“N2”, the System will search for records with numbers that begin with “N2”.  The more 
letters or numbers you enter, the narrower your search will be.

You can also use the wildcard character at the beginning of a search string.  For 
example, if you enter *123, the System will find records with collision numbers that end 
in “123”.

Finally, you can search by letters or numbers that lie in the middle of a string. For 
example, let’s say you enter *044* in the collision number field.  The System will find 
any records with collision numbers that have 044 somewhere in the middle (meaning, 
anywhere between the very first digit and the very last digit).

So, to sum up, your search criteria can be set in the following ways:

Full search entry (for example, a complete record number or a complete last 
name, such as “Jones”)

Beginning characters, using one or more (e.g., N*, N0*, N0711*, JON*)
Ending characters, using one or more (e.g., *3, *23, *723, *NES)
Middle characters, using one or more (e.g., *4*, *04*, *RES*)

Keep in mind that you can use the wildcard for any field: Collision Number, First Name, 
Middle Name, Last Name, Street Address, Vehicle License Number, and Phone 
Number.

But also keep in mind that you don’t have to use the wild card  -- you can use a whole 
search entry, such as full name or a street address.  It all depends what type of results 
you want: whether you want a range of results or more specific ones.  For example, if 
you search by a specific street address (e.g., “1200 Main Street”), you will only get 
records that contain that address (provided there are any in the System).

198



Let’s see the Collision Lookup in action.

In this example, we’re searching by Collision Number and Last Name using the wildcard 
feature.  We’ll place *88* in the Collision Number field to find records that contain those 
numbers and S* in the Last Name field to narrow it down to records that contain last 
names beginning with S.

Fig. 7.26

Hitting the Run Query button will produce a report similar to this one:

Fig. 7.27
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As you can tell, the report lists each search result in numerical order (by accident 
number) and arranges basic data under specific headings.  Note that some of the 
headings are staggered.  For example, Occupant, Non-Motorist, and Registered Owner 
are listed in the same column.  Each result has three rows and will display this 
information (if available) in the same order as they are listed in the heading.

Of course, the real point of this search is to find specific collision records.  Once you’ve 
run the query and the search results appear, you can select a specific record and open 
it.  To do this, locate the record you want to see in the list and move your mouse cursor 
over it.  This record will be highlighted in yellow; click once on it with the mouse, and the 
System will open it in a standard, printable format.

Fig. 7.28

The Scene Information sheet appears, with all of the available data in their appropriate 
fields, as you would expect.  And even though the Scene Information sheet opens first, 
the whole record is there for you to see.  Use the navigation buttons at the top to reach 
different sections of the record. V1, V2, and V3, for example, will take you to Vehicle 1, 
Vehicle 2, and Vehicle 3, respectively -- although the number of vehicle buttons will vary 
from record to record, depending on how many vehicles were actually involved in the 
collision.  Sometimes, there will be additional navigation buttons, such as O/W for the 
Occupant and Witness form.

If you don’t want to view the sections of the record one-by-one, click the Show All 
button, which will show the entire report and all you simply to scroll through the record.
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Printing
If you want to print the record, doing so is fairly easy: just hit the Print button in the 
navigation bar at the top of the screen. 

NOTE: The Print feature will only print whichever section of the record you 
are currently looking at.  So, for example, if you are looking at the Scene 
Information Sheet and select print, the System will print out a copy of just the 
Scene Information Sheet, not the entire collision record.  The feature was set 
up this way for convenience, so that you can examine one section of a record 
at a time.  If you’d like to print out the entire record, choose the Show All 
option first and then, after the entire record appears, hit Print.

When you are finished viewing and printing the record, hit the Exit button to return to 
the search results.  

You can view additional records or, if you are finished, you can use the Back to Query 
Page link at the top of the screen to return to the Search Lookup page.

We have now covered Collision Queries.  It’s now time to take a look at Citation 
Queries.

7.10 Citation Queries

Like the Collision Queries, the Citation Queries provide powerful methods for searching 
and analyzing citation data.  To access them, just click on the Queries Menu from the 
Main Menu, and from there click on Citation Queries.

The System will open the Citation Queries Menu, which will display all of the available 
queries and reports (Fig. 7.29 below).
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Fig. 7.29

The Citation Queries and Reports include:

General Query. Run a query for all citation data in the System; you can limit or expand 
the query using a variety of parameters, including defendant name and address, driver 
license number, vehicle information, court date, court, and more.

Citations by Day and Time.  Ranks citations by date and time for a specified date 
range.

Citations by Gender.  Displays the number and percentage of citations per gender.

Citations by Area.  Breaks down the number and percentage of citations per area/beat.

Citations by Court.  Shows the number and percentage of citations according to court.

Cite Lookups by Person.  A powerful search function that allows you to lookup 
citations by person, as well as additional useful parameters.

Citations by Race.  Analyzes the amount of citations according to the race of the 
defendant.  

Citation Violation Breakdown.  As the name implies, this query breaks down the 
citations by violation.
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Cite Stat Detail.  Breaks down citations and violations by category, such as Violations 
(Unique), Total Hazardous, Total Non Hazardous, Total Radar Citations, and more.

Citation Township Breakdown.  Analyzes the number of citations per township.

Cites by Zip Code.  Displays and ranks the number of citations for each zip code.

Cites by Violator City.  Ranks the number of citations by the violator’s city.

Cites by Age Range.  Breaks down citations according to age range.

Cites by Age.  A little different than the previous one, this queries breaks down citations 
for each specific age.

Data Entry Stats.  Displays the data-input stats for each citation.

Data Entry Stats Summary.  Displays data-input statistics, including the total number of 
reports, the average time for data entry, the total hours, and more.

7.11 How to Run a Query

The majority of the Citation Queries work the same way, and so we won’t examine each 
one of them in detail.  Instead, we’ll take a look at a how to run most of the queries by 
using one as an example.  However, there are several queries that are unique and 
required step-by-step instruction, and these will be examined in depth.

Let’s begin with a regular citation query, such as Cites by Violator City.  The query 
opens with this screen:

Fig. 7.30
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Like most of the Citation Queries, this one is straightforward and doesn’t require you to 
input a lot of information first.  The most important parameters are the Start Date and 
End Date because every query needs a date range.  By default, the query will 
automatically display the dates that have been set up in the Traffic Management 
Configuration, but you can certainly change the dates by simply clicking in the date 
fields, removing the existing dates, and inputting new ones.

When changing the dates, make sure to use the standard, eight-digit format: two digits 
for the month, two for the day, and four for the year.  So, for example, if you want to 
input a start date of March 7, 2005, you would type “03” and then “07” and then “2005.”  
Don’t worry about the slashes, though -- the System will put these in automatically.

The only other query parameter is Officer ID.  This is optional.  If you leave the field 
blank, the query will include all citations by all officers.

However, if you want to run the query for a specific officer, open the drop-down list in 
the Officer ID field, scroll until you find the officer you want to query by, and click on the 
name with the mouse.

Fig. 7.31
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With the dates and the officer ID (if necessary) set, just hit the Run Query button at the 
top to execute the query.

The Reset Query button will return the query to its default settings -- the default, 
configured date and an empty Officer ID field.  You can use this when you want to clear 
the parameters you’ve entered and start again.

When the query runs, it produces a report:

Fig. 7.32

The report has a readable layout, displaying the date range that was used, the total 
number of cities, and the total number of citations.  Then, the actual query results are 
displayed in the main portion of the report.  Because this was a query of citations by 
violator city, the report shows the city on the left, the total number of citations for that city 
in the center, and the percentage that each city makes up in the total number of cites.

Fig. 7.32 is just a detail of the report, as it can be long, depending on the number of 
cities.  As with all collision reports, this citation report (as well as the others) displays the 
Settings Used for Query at the end.  In most cases, this will include the date range you 
specified and officer information if you selected a specific officer ID.
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7.12 Printing the Report

Each citation report can be printed for your use, in the even that you’d like to review a 
collision, to maintain hard copy files, to have reports available without having to run 
queries again, or to analyze citation data.

NOTE: Before printing a report, it’s important to ensure that the page margins 
are set properly.  Because some of the reports are in landscape (instead of 
portrait), there is the possibility that the entire report won’t print if the margins 
are too wide.  The page margins should be set to ¼ (.25) inch on all 
sides.  To do this, simply go to the File menu at the top left of your internet 
browser window.  From the File menu, select Page Setup.  Depending on 
which browser version you are using, the location of the margin settings will 
vary; but just look for Margins and set each of them to .25.  When finished, 
click OK.  Once you set the margins, the browser should maintain the 
settings (even after the computer is restarted or shut down) until you 
manually change them again.

When you’re ready to print the report, simply go to the File menu in the browser and 
select Print.  On occasion you might have to change the page layout to Landscape if 
the report doesn’t fit the standard “portrait” layout (you can see what it will look like by 
selecting Print Preview in the File menu).  To change the layout, click on the Layout 
tab in the Print dialog box and select Landscape.  Then hit OK to print the document.

Most of the Citation Queries work just like the Cites by Violator City Query.  Let’s now 
take a look at the unique citations queries, those that operate differently and that require 
some explanation.

7.13 General Query

The General Query is an extensive, all-purpose query that offers the widest range of 
query parameters and allows you to search all available citation data. You can include 
and exclude as much data as you want -- you can search all citations for a specific date 
range, for example, or you can limit the search in a variety of ways: by citation number, 
township, the defendant’s name or address, driver license, vehicle make, and more.  
This makes the General Query a very powerful tool; there might be times when you just 
want to find a citation for a certain defendant or only those citations for a certain court.

The General Query consists of a series of sections that contain various parameters.  
Let’s take a look at these sections.
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Fig. 7.33

Type, Number, and Township
At the top of the General Query are two fields for Type: you can use these to specify 
and search by a specific citation type.  The first drop-down field has two values: = and 
Not.  If you select =, the search will include whichever citation type you select in the 
second field.  If you select Not, it will exclude whichever citation type you select.

Next select a citation type: Misdemeanor, Traffic, Juvenile, or Warning.  If you want to 
search all citation types, just leave the field at its default wildcard (*) setting.

NOTE: All of the drop-down fields in the General Citation Query have a 
asterisk/wildcard (*) set by default.  This simply means that, if you do not 
select anything from a drop-down list, the Query will include all possible 
selections in the search.  For example, let’s say you first want to search 
citations involving blue vehicles.  You would select “Blue” from the Color drop-
down list.  But, later, let’s say you don’t want to limit your search to blue 
vehicles; you want to include all vehicles.  You would then just leave the Color 
drop-down list at *.  This works the same for all drop-down fields in the 
General Citation Query.

For the Citation Number field, you can leave the field blank (the search won’t be limited 
to a citation number), input a complete citation number (the search will bring back that 
one particular cite), or input several characters and a wildcard (*). For details on using a 
wildcard, see Section 7.9 on Collision Lookup, where we explain how to use a wildcard.  
Essentially, you can use the * before or after a character or a set of characters to limit or 
extend your search: for example, N* will return all cites with citation numbers beginning 
with N; *888 will return all cites with numbers ending in 888; and *44* will return all cites 
with numbers that have 44 somewhere in them.
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NOTE: Any field in the Citation General Query that is labeled with a * can 
accept wildcards: for example, *First, *Street, *SS #, and so on.  Remember 
that the more characters you include in a wildcard search, the less extensive 
the search will be.  Using N*, for example, will likely bring back more results 
than something more specific, like N123456*.  The same principle holds true 
for any of the wildcard fields, such as defendant name.  J* is more likely to 
yield more results than Jone*.  Also remember that, if you leave the field 
blank, you will get more results than if you input characters or words.

The last field in this section, Township, allows you to select a specific township to 
search by (or leave it blank to include all of them).  There are two buttons: Reset and 
Run Query.  We’ll return to these later -- we need to look at the rest of the query -- but 
these buttons do exactly what you think they do: Reset clears the query fields and 
allows you to start over, while Run Query starts the search and produces the results.

Defendant
This section lets you search by defendant-related criteria, such as the defendant’s 
name, address, race, sex, driver license, or other parameters.  You can, for example, 
search for all male defendants for a specific date range or all those who live in a specific 
zip code.

Fig. 7.34

Use any of the defendant-related fields you need to narrow your query.  In the free-entry 
fields (such as name and address), you can input complete criteria or use a wildcard 
search, while in the drop-down fields (Race, Sex, Hair, Eyes, and Driver License State), 
you can limit your search by making a selection.

There are three fields that don’t contain wild cards because they allow you to search by 
ranges.  These are Age, Height, and Weight.  Enter a From value and a To value in 
these fields (or leave them blank to include all ages, heights, and weights).
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Fig. 7.35

Vehicle
In this section of the Citation General Query, you can limit the search according to 
vehicle-related criteria.  Use drop-down lists to select a Make, Color, or the License 
Plate State.  Use the free-entry fields to input full criteria or wildcard searches.

Dates, Count, Officer, and Court
In the final sections of the General Query, you can search by specific dates, by a 
specific violation/count, by the officer’s name, or by the court.

Fig. 7.36

By default, the Citation Dates (the date range by which you query) are the same dates 
that are set up in Configuration and that appear in all queries.  You can change the 
dates by deleting the default ones and inputting new dates.  If you would rather query by 
Court Date, input a date in this field, using the standard eight-digit format (two digits for 
the month, two for the day, and four for the year).

To query by Count, open the first drop-down list to select the code and the second to 
select the description.

To query by the name of the Peace Officer Preparing Citation, open the drop-down list 
for this field, locate the officer’s name, and select it by clicking on it with the mouse.

Finally, you can query by a specific court; simply open the drop-down list in the Justice 
Courts Of, locate the appropriate court, and select it.
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NOTE: Keep in mind that the Citation General Query is a very flexible search.  
You can search by a single criteria, or you can search by a combination of 
them.  Use the fields across the various sections to combine criteria if you 
need to.  For example, you can query for all cites with citation numbers that 
begin with N, with defendants whose last names begin with S, and with 
vehicle makes that match “Civic.”

When you have set the search criteria in the General Query, you can execute the 
search by clicking the Run Query button at the top.  If you want to clear the fields and 
start from scratch, just hit the Reset button.

When the results appear, you’ll see them organized in a readable report:

Fig. 7.37

In this example, we did a query for all citations that contained defendants whose names 
ended in Jo*.  Each citation has its own row in the report, with the data for each one 
arranged in columns.  Column headings at the top tell you what type of data is listed 
(e.g., Cite Number, Cite Date & Time, Primary Road, Secondary Rode, Code 1, and so 
on).  Basic report information is contained at the top of the report, where you can see 
the date range and the total number of records for your query.  The bottom of the report 
(not shown here) contains information about all of the settings you specified for the 
query.  Therefore, if you set any of the additional query parameters, those settings will 
be displayed at the end.
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7.14 Cite Lookups by Person

The Cite Lookups by Person is similar to the Collision Lookups by Person that we 
covered in Section 7.9 of this chapter.  It’s a powerful, useful search that allows you to 
search citations by person (defendant), or by particular information related to a person.  
As you can see in Fig. 7.38, there are several search parameters, including Citation 
Number, Name, Driver License Number, License Plate, License Plate State, Collision 
Dates, and Court Date.  You can search by any one of these parameters or by a 
combination of several of them.

Fig. 7.38 

The Cite Lookups by Person allows to search by whatever criteria you have: by a 
citation number, a defendant’s name, a license number, or other data.  You might, for 
example, want to look up all records that begin with “S” or that involve an individual with 
the last name of “Jones” -- or both.

As with the Collision Lookups, the important thing to remember is that the more 
information you put into the query, the narrower your search will be -- and, also, you can 
use the wildcard (*) feature to your advantage.

For full details on running wildcard searches, refer to Section 7.9.  Essentially, you use 
the asterisk (*) before or after letters or numbers to get a range of data.  For example, if 
you enter N* in the Citation Number field and then hit Run Query, the System will search 
for all citations with numbers than begin with N.

Of course, you don’t have to use the wildcard -- you can easily search by inputting full 
information (full names or citation numbers, for example) or by leaving fields blank.
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When you are ready, hit the Run Query button to execute the query.  If you wish to start 
over, use the Reset Form button.

The results will display in a tabular, readable format.

7.39

In this particular query, we searched for citations with defendants whose last names 
begin with S.  The results are listed in rows with the most essential information showing: 
Cite #, Citation Date, Violation Description, Violator Name, Court Date, and Load File.

From the results, you can select a specific record and open it to view and print it.  To do 
this, locate the record you want to see in the list of results and move your mouse cursor 
over it.  The record will be highlighted in yellow.  Click on it once with the mouse, and 
the System will open it in a standard, printable format.

Fig. 7.40 below shows an example.
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Fig. 7.40

Use the navigation buttons at the top of the screen to view different portions of the 
citation.  You can also view the citation together with violator’s disposition or the citation 
together with the narrative.  To print each section use the Print button at the top.

NOTE: The Print feature will only print whichever section of the citation you 
are currently looking at.  So, for example, if you are looking at the Narrative 
and select print, the System will print out a copy of just the Narrative.  The 
feature was set up this way for convenience, so that you can examine one 
section of a citation at a time.  To print just the citation, select Citation and 
then hit Print or use the Citation and Narrative or Citation and Description 
and then hit Print.

Let’s now take a look at a few more unique citation queries.
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7.15 Citation Log

The Citation Log, like the Collision Log, is a simple query that shows you all citations for 
a specified time period.

Fig. 7.41

To execute the query, set the Start Date and End Date.  The default dates that were set 
up in Configuration will automatically appear, but you can alter the dates simply by 
removing the defaults and inputting the date range you need.

Next, you can select a specific officer in the Officer ID field if so desired.  Doing this will 
provide you with a log of all citations for that one officer for the specified date range.  If 
you leave the Officer ID field at its default (*) setting, the log will include citations by all 
officers for that date range.

When ready, hit Run Query.

Fig. 7.42
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The Citation Log Report displays the date range you used and the total number of 
citations for that range.  As you can see in Fig. 7.42, the bulk of the report includes a log 
of the citations, each listed in its own row with the following information: citation number, 
date, name (of violator), vehicle license, court, and court date.

Like all queries, the Citation Log Report also displays “Settings Used for Query” at the 
end of the report (it will display the date range and the officer ID, if it was selected 
before running the query).

To print the Citation Log, simply go to the File menu and select Print.

7.16 Data Entry Stats and Data Entry Stats Summary

These two queries are quite similar to the Data Entry Stats queries in the Collision 
Menu.  They allow your agency to understand the efficiency of data entry in the Traffic 
Management System: how many citations have been entered over a specified period of 
time, the average time it takes to input a citation, and the longest and shortest times for 
record entry.  You can also see similar statistic for each user.

The Data Entry Stats query provides a run-down of data-entry stats and then information 
on each collision record entered.  The Data Entry Stats Summary is a little different; it 
displays data-entry stats by user.

Make sure you have the date range you want and then select Run Query.

Fig. 7.43

The report (Fig. 7.44 below) displays stat totals at the top, including the Longest time it 
took to input a citation, the Average time it took to input a cite, and the Shortest time.  
The report also displays the Total Time spent inputting all citations, the total number of 
cites, as well as the total times the minimum number of hours.

Below these stats is a readable table of all the citations returned for the date range you 
queried, with each citation record displayed in a row.  The table shows five types of 
important information: Entered By (who input the record), Citation Number, Entry 
Started (when the citation first started being entered), Entry Completed (when the 
citation was finished), and Elapsed Time (how long it took to complete the citation 
input).
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Fig. 7.44

The purpose of the Data Entry Stats report is to show and analyze how quickly records 
are being inputted into the System and how many personnel hours are being spent on 
records input.  These stats can be useful in determining records management efficiency 
and allocation of agency resources.

To run the Data Entry Stats Summary query, you do essentially the same thing you did 
for the Data Entry Stats query: input a date range and then hit Run Query.  The 
Summary report is different:

Fig. 7.45

Like the first Data Entry Stats report, the Summary report displays the total statistics at 
the top, but in the main table it displays statistics for each user, with the user’s ID listed 
in the Entered By column.  It then shows the Shortest amount of time it took for each 
user to input a record, the Longest amount of time it took that same user to input a 
record, and the Average time it took for that user to enter a record.

In addition, the Summary also displays the Total Reports entered by each user and the 
Total Hours each user spent inputting records.

Like the previous Data Entry Stats query, the Summary query provides valuable 
information about data-input efficiency (in this case, by user) and can assist your 
agency in understanding its allocation of resources.
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Printing the Data Entry Reports
To print either the Data Entry Stats or the Data Entry Stats Summary report, just open 
the File menu at the top of the browser and select Print.  If the report does not fit within 
the margin, you can set the margins in the Page Setup option in the File menu.  
Remember that you can see how the report will look before it prints by using Print 
Preview.

We have now finished looking at the Collision and the Citation Queries in the Traffic 
Management System.  To learn about Graphs and Charts, Officer Activity Reports, and 
Records Output, go to chapter eight.
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CHAPTER EIGHT

CHARTS, OFFICER ACTIVITY REPORTS
AND RECORDS OUPUT

The Collision and Citation Queries are useful tools for examining traffic and citation 
data.  The Traffic Management System features additional analysis tools that are 
equally powerful and useful, particularly color-coded charts that allow you to break-down 
and understand collision patterns. These charts cover vehicle and driver factor, roadway 
conditions, collision type and highway factors, collisions by year, injury severity, and 
much more.

In addition, the Queries section of the Traffic Management System also includes Officer 
Activity Reports and a sub-section for Records Output, where you can send collision 
and citation data to your agency’s records-management system and transmit records to 
the courts.

Charts, Officer Activity Reports, and Records Output are all important, but we’ll begin 
with the Charts, examining how to use and understand them in detail.

8.1 Charts

All charts are available in a single query screen (which is rather convenient).  To access 
them, simply select Queries from the Main Menu.  From there, select Charts.  The 
Charts screen will open (see Fig. 8.1 below).

The Charts screen is divided into several sections.  On the left are the sections that 
contain all of the query parameters -- the criteria you will query by.  The Charts screen 
has an extensive array of parameters, much like the General Query that we covered in 
Section 7.5 of Chapter Seven.  We’ll look at those parameters and the steps involved in 
running a query.

On the right of the screen are buttons, divided into two types: Pie Charts and Bar 
Charts, and each type has a variety of query options.  After selecting the query 
parameters on the left of the screen, you simply select one of the available charts on the 
right, depending on the type of collision-related information you want to see and the 
format in which you want to see it.
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Fig. 8.1

Let’s take a look at how to produce graphs and charts, beginning with the various 
search parameters that are at your disposal.

Minimum Graph Value
The Minimum Graph Value is optional, but it can be very helpful with charts, especially if 
you have a significant number of records in your database. Essentially, the Value sets a 
limit for your charts, displaying only those elements with a total number of collisions 
above the minimum value, and excluding all those below that value.  In other words, 
let’s say you want to produce a pie chart for Vehicle and Driver Factors. The chart will 
show specific factors such as Unsafe Speed, Following Too Close, Unsafe Lane 
Change, and others, and it will also show the corresponding number of collisions for 
each factor. For example, for a given time period, it might show “Unsafe Lane Change 
353 (23%),” with the 353 being the number of collisions and the 23% denoting the 
percentage that this particular factor takes for the all collisions for that time period.
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In some cases, however, the chart may display a large amount of factors, including 
those that have a small number of corresponding collisions.  For example, it might 
display Obstructed View 4 (.05%).  In a situation like this, you might not find the 
information very useful and will more likely be interested in the factors that cause the 
most amount of collisions.

You can exclude some elements from your search by setting the Minimum Graph Value.  
Exactly what that value is will depend on the records in your database, the exact results 
you get for each query, and your own specific needs when running the query.  You might 
have to run several queries before you determine the optimal minimum value -- 
although keep in mind that this value might change if you search for a larger or smaller 
date range.

However, let’s say that you’ve determined that you want to set the Minimum Graph 
Value at 50.  This means that the chart you query will not show results with less than 50 
collisions.

To set the Minimum Graph Value, just enter the value in the available fields. The Top 
field will set the value for the first, or top, chart, while the Bottom sets the value for the 
second one (some of the Charts queries will feature two charts).

Main Query Parameters
The Main Query Parameters are the ones you will use most of the time.  When selecting 
parameters for a chart, remember that they work just like the Collision and Citation 
Queries: the more parameters you set, the narrower your search will be. The fewer 
parameters you set, the more extensive your search will be.  The amount and type of 
results will depend on your query parameters.

Fig. 8.2
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The most important parameters here are the Start Date and End Date because every 
graph and chart (like every query) requires a date range.  By default, the query 
automatically includes start and end dates that have been set up in the Traffic 
Management System Configuration.  You can change the dates by simply clicking in the 
Start Date and End Date fields and entering a new date range.

City.  With this option, you can query collisions that occurred in a specific city.  Open the 
list to select a city.  If you leave this option alone (set to *), the system will include 
collisions in all cities.

Intersection Related.  When set to “yes,” the query will include only those collisions 
that are intersection related; in other words, collisions that occurred within fifty feet of an 
intersection, as well as rear-end collisions heading towards the intersection within 150 
feet of that intersection.

If you select “no,” the query will exclude intersection related collisions.

By default, this option is set to *.  This simply sets the query so that it makes no 
distinction and includes matching citations that are intersection related as well as non-
intersection related.

Select the Streets.  If you want to query a specific location, you can select a primary 
road (or street) and a secondary road (cross street).  First, open the Street list to select 
a primary road.

Fig. 8.3

To input the street, just click on it with the mouse.  In this example, we’ll select Main 
Street.
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Once you’ve selected the primary road, the system fills in the Cross Street list with 
those roads that cross the primary road -- a very convenient feature that doesn’t force 
you to scroll through an entire list of city streets and guess which ones cross.

Open the Cross Street list and select a secondary road.

Fig. 8.4

Now, both streets have been selected:

Fig. 8.5
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NOTE: The Charts do not require you to specify an intersection.  The streets 
lists exist in the event that you want to query only one location, but if you want 
to query all locations, you can; simply leave the streets fields empty (i.e. leave 
the * in the fields).

Additional Query Parameters.
These parameters help you narrow the query to obtain more specific collision results.  

For example, let’s say you want to produce a breakdown of the number of head-on 
collisions for each day of the week.  Open the Vehicle Collision Type list, find Head 
On, and select it with the mouse.  Then, you just select Day of Week in the Bar Charts 
section on the right of the screen.

If there are other parameters that you want to query by, such as light or weather 
conditions, simply use those lists to make your selection. Remember that the more 
parameters you select, the more precise and narrow the your query will be.

You can also input a Start Time and End Time to query only those collisions that 
occurred within the specified time frame.  And, at the very bottom of the screen, you can 
input a Beat/Sector number, or a portion of one using the wildcard (*) feature (for more 
on how to use the wildcard, see Section 7.9 of Chapter Seven.

By default, all of the Additional Query Parameters are set to *, meaning that they 
automatically include all collision types, all locations of first event, all highway factors, 
and so on.  This provides you with the widest possible query for the date range you 
specify in the Main Query Parameters.

Fig. 8.6
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When You Are Ready to Produce a Chart
When you have set the date range, selected streets (if applicable), and set all other 
necessary query parameters, use the buttons on the right to produce a chart.  You can 
select from Pie Charts or Bar Charts.  The specific chart type is labeled on each button. 

The System will query the database and then display your results in a readable, color-
coded chart.

Fig. 8.7

Fig. 8.7 shows the top portion of the Vehicle & Driver Factor chart.  Each slice of the pie 
represents a specific vehicle factor, displaying that factor as well as the number and 
percentage of collisions that correspond with it. 

The bottom portion of the chart shows a similar graphic, this time a breakdown of the 
most important driver factors.

Fig. 8.8
224



These pie charts are helpful because they give you an immediate, easily 
understandable graphical representation of various collision data -- in this case, it’s easy 
to see right away which vehicle and driver factors dominate and which ones occur less 
frequently.  In addition, the charts provide specific numerical statistics to help augment 
your understanding of collision factors and patterns.

Printing the Chart
Like all queries and reports in the Traffic Management System, the charts can easily be 
printed to any Windows-compatible printer.  For the charts, it’s especially helpful if you 
have a color printer. 

For certain charts, you might have to alter the layout and the page margins, if they have 
not been set already.  To do this, go to the File menu in your browser and select Page 
Setup.  A dialog box will open; in the Orientation field at the bottom, select either 
Portrait (8 ½ x 11) or Landscape (11 x 8 ½) for the layout.  In the Margins area, input 
the margins you need in increments of inches.  For best results, you should set them at 
.5 or .25 inches.

When you are ready to print the chart, simply go to the File menu in the browser and 
select Print.

Working with Bar Charts
Creating a bar chart is the same as creating a pie chart: set the query parameters, and 
then select one of the bar chart options by clicking the appropriate button.  Like the pie 
charts, bar charts are color-coded.

Fig. 8.9
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Fig. 8.9 above shows a bar chart for Vehicle Factor.  In this example, the number of left 
side of the chart (what’s technically known as the “Y axis”) shows the number of 
collisions, while the bars each represent a specific vehicle factor (as with all bar charts, 
the height of the bar signifies the amount of collisions for that factor).

Each bar has its own color; using the legend on the right, you can see which vehicle 
factors correspond with the colors.  The bar chart gives you an easily understandable, 
graphical summary of collision data.  In this case, you can see which vehicle factors 
played the largest roles in collisions for a given time period, and which vehicle factors 
were less important.

Settings Used for Query
At the bottom of each chart you’ll see a listing of the settings used for the query: each 
parameter that you select will appear here, so that when you are viewing the chart you’ll 
immediately be reminded of your settings -- and anyone else reading the chart will know 
what settings you used.  Knowing the settings is important to understanding the data in 
the chart.

Using Charts
This section, and the examples it contains, should give you ample knowledge for setting 
parameters and producing charts.  You might want to take some additional time 
producing some of the charts not covered here to give yourself a sense of how powerful 
and useful the charts are.

Let’s now look at the other features in the Queries section of the Traffic Management 
System.

8.2 Officer Activity Reports

The Officer Activity Reports are easy-to-use queries that allow you to view the number 
of citations each officer has written, the types of citations that are written, and the 
number of citations by each officer per violation.  There are three Officer Activity 
Reports: the main Officer Activity Report itself, Citations by Officer, and Citations by 
Type.  All they require is a date range, while two of the queries allow you to search by 
Officer ID.  Let’s take a look at the main Officer Activity Report.

Fig. 8.10
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As with all queries, this one requires a date range.  By default, it will show the Start 
Date and End Date that were configured for the System, but you can enter any date 
range you want by clicking in the Start Date and End Date fields, deleting the existing 
dates, and writing in new ones.

The Officer ID field is optional.  If you don’t use it, the Report will include all officers that 
are in the System.  If you select an ID, the Report will show activity only for that officer.

In Fig. 8.11, we’ve run the Report to include all officers.

Fig. 8.11

The Officer Activity Report essentially shows the total number of citations and violations 
written by each officer, along with a breakdown of the violations.  At the top, the Report 
has two legends: the first shows useful statistics for Date Range, Total Citations, Total 
Violations, Total Officers, and Average Citations per Officer; the second provides a key 
to the main chart in the report, showing each violation type and its corresponding letter 
(E, for example, signifies speed, F signifies Failure to Yield, and so on).  How these 
letters work will become evident when you look at the main chart.
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In the main chart, the Report displays citation statistics for each officer, with the officer’s 
ID on the left, followed by the total number of citations and violations written by that 
particular officer.  Then, in each box that is labeled with a letter, the Report will display 
the number of citations per violation type (if applicable).

The Officer Activity Report provides you and your agency with an in-depth tool for 
understanding officer citation-writing activity in the field, enabling you to see the quantity 
and types of citations each officer is writing.  This information can help your agency 
manage its resources more effectively and understand traffic enforcement in your city.

Citations by Officer and Citations by Type
The other Officer Activity Reports provide more basic, but still useful, information about 
the number of citations written by each officer and the total number of citations for each 
type.  Both are very easy to run, especially the Citations by Officer, which only requires 
a date range.

Fig. 8.12

Use the pre-configured date range or input your own and select Run Query.

Fig. 8.13
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As you can see in Fig. 8.13 above, the Citations by Officer Report is very readable.  It 
displays each officer and ID and the total number of citations written by the officers for 
the date range you entered.

The Citations by Type is a different kind of report, but it too is easy to run and easy to 
read.  First, select a date range and then, if you need, an Officer ID.  If you leave the 
Officer ID field at its default (*) setting, it will provide results for citations written by all 
officers.

Fig. 8.14

The report itself breaks down citations into the basic types (traffic, warning, accident, 
parking, misdemeanor, and so on) and shows both the quantity for each and the 
percentage of the total that each type takes up.

Fig. 8.15

Both the Citations by Officer and Citations by Type provide you and your agency with 
handy information about the quantity of citations; this knowledge can help with 
understanding and planning traffic enforcement.  You can easily print both reports by 
opening the File menu in your browser and selecting Print (use Page Setup if you need 
to adjust the margins or the layout).

Let’s now move on to the last part of the Queries: Records Output.
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8.3 Records Output

The Records Output feature in the Queries section of the Traffic Management System 
allows you to send collision and citation records in electronic format to records-
management systems and court databases.  The process is easy, automated, and takes 
only a few moments.

To access the Records Output Menu and see what options you have, go to the Queries 
Menu and click on the Records Output link.  A new menu will open:

Fig. 8.16

There are several types of records output, some for the current day, others for a date 
range, as well as a Court Transmittal that allows you to select the specific court to which 
the records will be sent.

RMS Output Collision and RMS Output Citations.  Both of these options will output 
either collision records or citation records to your records-management system.  The 
records that will be transferred this way are for the current date only.  This is 
convenient; when an officer syncs the day’s collision records or citations at the end of a 
shift using the RMS Output, the records are easily transferred with a one-step process.  
Just click the appropriate link.  The System will output the records and will then confirm 
that the data has been transferred and will note how many total records were sent.

RMS Output Collision (Date Range) and RMS Output Citations (Date Range).  If 
you need to output collisions or citations for more than single day (and anything other 
than the current day), use these options.  All you need to do is input a date range (see 
Fig, 8.17 below) and click the Output button.  The System will transfer the data and then 
confirm that the output is complete.
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Fig. 8.17

When finished, hit the Back button to return to the Records Output Menu.

Court Output Citations.  Like the RMS Output Citations, the Court Output Citations will 
send citation records to the court for the current day.  Clicking on the link will 
automatically send the cites.

Court Transmittal.  To send citations for a range of dates (anything other than the 
current day), use Court Transmittal.  Clicking on the link will open a basic input screen.

Fig. 8.18

The Start Date, End Date, Start Time, and End Time fields will contain the default dates 
and times, but you can change these by clicking in each field and entering new dates 
and times.

Next, open the Court drop-down list (Fig. 8.19 below) and select the court to which you 
want to transmit the citations (you must select a court).

After selecting a court, just hit the Run Query button at the top right.
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Fig. 8.19

The System will confirm that the records were sent.

Hit the back button on your browser to return to the Court Transmittal screen, and then 
hit back again to return to the Records Output Menu.

This concludes our chapter on Charts, Officer Activity Reports, and Records Output.
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